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How Do I Start?
When you start Mavis Beacon, you'll see the Welcome dialog, where Mavis gives you 
three choices:

For an orientation tour, select "Meet Mavis"

For immediate help, select "Help for New Users"

To start your typing lessons, select "Start the Lessons"

If you are a new typist, Mavis will ask you your name followed by a few questions 
concerning your typing ability and age and the lessons will begin.

If you need help at any time, press the function key F1 

Have fun and good learning!



Learning to Type
Mavis Beacon Teaches Typing gives you numerous paths to typing success.    You can let 
Mavis lead you through a complete curriculum or you can freely move around the system
and spend time only on the subjects of most interest to you.    Here are some topics to 
help you choose how to best benefit from Mavis' instruction:

Standard vs. 10-Key Lessons
Chalkboard
Workshop
Classroom
Race Game
Grocery Checkout Game



Standard vs. 10-Key Lessons
Mavis Beacon Teaches Typing has two main modes of keyboard instruction.    The first, 
called Standard Typing, teaches you the skills you'll need to perform everyday typing 
tasks.    The second teaching mode, called 10-key typing, teaches you to perform speedy 
numerical data entry task as required for operation of adding machines or cash registers. 

To toggle between standard and 10-key lesson mode, choose the Take 10-Key Lessons 
selection from the Lessons menu.    To change back, choose the Take Typing Lessons 
selection.



Chalkboard

    

    

    

The Chalkboard is where you get your assignment from Mavis.    The suggested lesson is 
designed to quickly correct any problems that you appear to have.    You choose what you
want to do next by selecting one of the choices beneath the board.    Usually, you just 
accept the offered suggestion by choosing OK.

OK: Choose OK if you like the lesson Mavis has offered.

Next: If you do not want to take the lesson Mavis has suggested, choose Next, and a
new lesson is presented on the board.

First: Choose first to return to the First suggestion Mavis offered you for this lesson.

Last: Re-do the previous lesson from this session.    If you have not yet completed 
any lessons during the current session, this choice is not available.



Workshop

Mavis directs you to the Workshop when she's found that you have a specific problem 
that needs attention.    A number of teaching aids are available to help you, such as:

Speed meter:  This meter shows your current typing speed in words per minute.

Accuracy, Speed and Completion:  The three bars at the left side of the screen 
labelled A, S and C show relative measures of Accuracy, current Speed adjusted 
for errors and percentage Completion of the current exercise.

Clock:    At the right side of the screen is an analog clock which shows how much 
time you've spent in the current exercise.

Metronome:  Mavis often suggests that you practice with the metronome to build 
rhythm in your typing.

The operation of all of these features can be modified in the Settings dialog available 
through the Typist Options selection of the File menu.



Classroom

Mavis takes you to the Classroom after you've been 
given a suggestion for improvement or have learned a 
new concept.    In the Classroom, you'll work on text 
selected specifically to help you reinforce what you've 
learned.



Race Game

The objective of the typing race game is to type with greater speed and accuracy than 
the pace car, which travels at a preset speed (usually just a little bit faster that you have 
been typing to give you a challenge).

To play, just type the words displayed in the sky.    Your current speed and accuracy 
appear on the two meters.    The number of 'miles' you race appears in the odometer.      
When your average adjusted words per minute score is greater than the pace car's you 
will pass the pace car and you'll be able to see it in your rear view mirror.    

But watch out - if you can't keep the pace, the challenger zooms ahead and disappears 
in the distance.



Grocery Checkout Game
The Grocery Checkout game tests your 10-key speed in the Grocery Store, where grocery
items travel past the cash register.    When an item reaches the price scanner (shaped 
like an 'X' on the counter) its price will be shown on the screen below the item.    

You must enter the price quickly on the numeric keypad or the item will fall to the floor.    
If you enter the correct price, the grocery item will fall into the waiting grocery sack.



Main Menu Commands
Mavis Beacon's main menu contains the following items:

File
Lessons
Keyboard
Style
Progress
Help



"File" Menu Commands
The File menu contains commands to enroll a new student, remove a student and modify
student options:

New Typist...
Delete a Typist...
Typist Options
Typist Personal File...
Exit



"New Typist..." Menu Item
Use this option to log in as a new or different typist.



"Delete a Typist..." Menu Item
To remove a typist from Mavis' records, select this option.    It deletes the user's name 
and all record of typing progress.    Be careful - once a user is deleted, there is no way to 
get any of the information back.

You are not allowed to delete typists if you are only browsing.



"Typist Options" Menu Item
Mavis allows you to customize the typing environment to meet your needs.    When this 
item is selected, Mavis displays the Settings dialog where you make your selections.    If 
you press the Save button, this data will be restored each time you log in.

Mavis will monitor your progress and make appropriate choices for all of the listed 
parameters.    If you to accept her suggestions, the Settings Dialog gives you control over
many of the features that are used to create your lessons.    Included are:

Guide Hands:    Turn the shadowy Guide Hands on/off.    If Guide Hands is on, when 
the keyboard is displayed in the Regular Typing lessons, the guide hands show 
you the proper finger placement for the last key pressed.

Keytops:    Turn the keytop labels on/off.

Meters:    Show/hide the Keyboard Meters that display your current typing speed.    
When Meters are on, in the Workshop digital displays show your current speed in 
words per minute and bar displays show accuracy, adjusted speed and 
percentage of lesson completed.

Clock:    Show/hide lesson clock.    When the clock is displayed, it shows how much 
time you've spent in the current lesson.

Cursor:    Turn the typing cursor under the current letter on/off.    

Metronome:    Turn the metronome on/off.

Metronome Speed:    Change the speed of the Metronome to adjust your typing 
speed.    Mavis will normally set this value automatically, but you may adjust it 
here.



Race Car Speed:    Set the speed of the pace car in the Race Game    Mavis will 
normally set the speed automatically, but you may change the setting 
here.

Accept Errors:    Choose to accept your typing errors or be forced to correct them 
before continuing.    Usually, errors are accepted.    If you make a mistake, the 
typing cursor moves forward and the error stays on the screen.    You can 
backspace and correct the error (unless backspace has been disabled from the 
Keyboard Menu    (For some lessons, Mavis wants to be sure that you type each 
letter correctly.    Then she sets Drill mode, which does not move the cursor 
forward if you make an error.    You must press the correct key to proceed.)



"Typist Personal File..." Menu Item

This item allows you to change your personal data which is maintained in Mavis' files.    
You'll go to the Personal Information dialog where you may make and save your changes.

In this dialog you can change your name, age group, typing skill level, speed goal and 
time limit for each lesson.    

The speed goal is used by Mavis to judge your progress.    Mavis will periodically 
adjust this number based on your performance.

The time limit sets the maximum amount of time you wish to spend in any one 
lesson.    Most lessons have unlimited time (indicated by a time limit of zero).    When 
the time limit is reached, Mavis will ask whether you want to continue.

The age group setting is used to select appropriate text material for the lessons.    

The skill level settings help Mavis determine a lesson plan tailored to help you learn 
efficiently.

Beginner:  If you have never typed before, or know nothing of the touch typing 
method, you are a Beginner.    If you can type a little, but no faster than 20 words 
per minute, you should still select the Beginner category.    These lessons will 
increase your speed and prepare you for the next step.

Intermediate:  A typing speed of over 20 words per minute puts you in the 
Intermediate category.    Here, Mavis reviews keyboard fundamentals, analyzes 
your typing, and suggests lessons to help you improve.

Advanced:    If you consider yourself an advanced typist, the Advanced lessons will 
help perfect your speed and accuracy.

Press the OK button to accept the changes or cancel to retain the original settings.



"Exit" Menu Item
When selected, the Exit item saves all student information and quits Mavis Beacon.



"Lessons" Menu Commands
The Lessons menu lets you change the course of Mavis' lesson at any time or even 
create your own custom lesson.    The following options are available:

Keys & Fingers
Free Typing
Play a Game Instead/Do a Drill Instead
Custom Lesson...
Take 10-Key Lessons/Take Typing Lessons
Pause Lesson
Quit Lesson



"Keys & Fingers" Menu Item

The Keys & Fingers tutorial helps you review the proper fingers for typing each key.    
Press any key and the guide hands will display the correct typing finger.    If you have 
Audio Messages turned On, some of the keys will be spoken as they are typed.

Press ESC to return to your previous task.



"Free Typing" Menu Item

Free Typing practice lets you type on your own for as long as you like.    This 
can ease the stress of a lesson, and allow you to concentrate on an area which 
may need improvement.



"Play a Game Instead/Do a Drill Instead" Menu Item

Instead of doing what was suggested on the Chalkboard, this lets you use the same 
lesson plan that Mavis has chosen, but in a the opposite format:    if Mavis had planned a 
drill, the menu item would appear as Play a Game Instead.    If a game has been 
suggested, the item would read Do a Drill Instead.    

In standard typing mode you'll go to the Race Game or to the Classroom or Workshop.    
In 10-key mode, you'll play the Grocery Checkout Game, or go to the Classroom.



"Custom Lesson..." Menu Item
Normally, Mavis creates customized lessons for you.    Mavis chooses a drill, the race 
game, practice work, text passages from over a dozen sources, emphasis on speed or 
accuracy, audio-visual aids, and special exercises.    If you want, you can make any or all 
of these choices yourself in the Custom Lessons dialog.

You may select from the following options:

Lesson Type:    Choose standard keyboard practice, the Race Game or the Guided 
Key Tour.

Emphasis:  Tell Mavis to emphasize Accuracy, Speed or General skills (a combination
of accuracy and speed).

Lesson Length:    Choose the number of words (of five letters average length) in the 
lesson.

Lesson Time:  A zero means unlimited length.    Enter another value to limit your 
time in the lesson.

Target Typing Speed:    This value will be used to set the metronome speed or the 
speed of the pace car in the racing game.

Text Format:    This setting determines the type of lesson you want.    In addition to 
Standard typing lessons you may choose:

Barrier:    Trains your eye to move ahead just the proper number of letters by the 
rather fiendish method of displaying only a few letters of practice text beyond the
point at which you are typing.

Transcription:    Gives you practice typing from text on paper.    In a transcription 



lesson, Mavis prints the text out on your printer before starting the lesson.    The 
text will not be shown on the screen - you must type it from the printed copy.

Pattern Typing:  Increases your speed by making you correctly type common 
letter sequences such as "ing".    If you make an error anywhere in one of these 
sequences, Mavis makes a distinctive sound, and the cursor snaps back to the 
beginning of the pattern.    To show you what is going on, the patterns within each 
word are highlighted.

Shift Key Practice:  Gives you practice by turning the first letter of each work in 
the lesson into an upper case letter.

Dictation Typing:    D  ictation Lessons   teach you to type while listening to a recorded 
voice, and work the same way as a Dictaphone.    Like Transcription Lessons, dictated 
lessons are not displayed on the screen, so you must listen carefully and use the 
pause and rewind controls to be as efficient as possible.

Lesson Text:  Select practice text from numerous sources.    You'll notice that some 
text is specially selected to emphasize certain problems such as left or right hand,
problem characters or specific characters.    You can take practice text from a file 
that you create yourself.    To use your own file, use your word processor to create 
a text file with no special control characters in it.    Make sure that it has the file 
extension .TXT.    Next, select the "Your Own File" option in the Lesson Text scroll 
box and tell Mavis to load your pre-made file.



"Take 10-Key Lessons/Take Typing Lessons" Menu Item

The menu item serves as a toggle to take you between the Standard and 10-Key typing 
modes.    A check mark on this menu item indicates that the current mode is 10-Key.



"Pause Lesson" Menu Item

Use this option to pause in the middle of a lesson or race game.    Choose OK to continue.



"Quit Lesson" Menu Item
Choose this option to end the lesson or game you are currently in, and return to the 
Chalkboard.    You can also press Escape to end the lesson.



"Keyboard" Menu Commands
The Keyboard menu commands let you tailor the keyboard operation to your taste with 
these options:

Keyboard Layout
End of Line Mode
Backspace Mode
Space After Periods



"Keyboard Layout" Menu Item
The Keyboard Layout menu item lets you choose the standard QWERTY keyboard layout 
or the Dvorak keyboard.    Most keyboards in the world use the QWERTY format (so 
named for the upper left six keys of the top letter row).    Some people, however, use an 
alternative keyboard layout called the Dvorak keyboard and Mavis can be configured to 
teach this configuration as well.

See your manual for more information on the differences between the QWERTY and 
Dvorak keyboards.



"End of Line Mode" Menu Item
On a typewriter, you must press the Return key at the end of each line.    However, most 
computer word processors have a feature called "word wrap."    This automatically moves
you to the next line when the current line is full.    This option lets you select either mode 
for Mavis' lessons.



"Backspace Mode" Menu Item
On word processors and some typewriters, the backspace key is an easy way to erase 
your typing mistakes.    On most typewriters, a mistake, once made, is hard to erase.    To 
mimic that kind of typing, use this option to disable the backspace key.



"Space After Periods" Menu Item
A common typing convention is to always put two spaces after the period or other mark 
at the end of a sentence.    Mavis normally asks you to do just that.    Use this menu entry 
to use a single space at the end of sentences if you prefer



"Style" Menu Commands
These menu selections let you set Mavis' teaching style:

Chatty Comments
Advice Level
Past Lessons Considered
Frustration Noticed
Play Games
Sounds
Music Is
Audio Messages



"Chatty Comments" Menu Item
If this option is on, Mavis will make occasional comments on your progress.



"Advice Level" Menu Item
Use this setting to tell Mavis whether to explain her lesson suggestions fully, or just tell 
you the problem, focus and suggested kind of lesson.



"Past Lessons Considered" Menu Item
This tells Mavis how much of her knowledge of your past lesson performance to use 
when deciding what lesson to present next.    If on, she will consider not only the 
immediate previous lesson, but all earlier lessons.



"Frustration Noticed" Menu Item
If this option is turned on, Mavis will pay attention to your percieved frustration level 
when suggesting future lessons.



"Play Games" Menu Item
Occasionally, Mavis suggests a game as a change of pace from the lesson flow.    For 
younger, students, games are suggested more often.    Use this option to tell Mavis how 
often to suggest a game.



"Sounds are" Menu Item

Mavis gives you audible cues when you make errors, when you end a lesson and at other
appropriate times.    You may choose a class of sound with this menu selection.    You may
choose from simple beeps, bits of music or silence.



"Music is" Menu Item
If you've chosen Music from the Sounds menu item, this selection lets you select the 
nature of the music.

When Mavis wants to get your attention, the sound you hear will be the one selected 
here.



"Audio Messages" Menu Item
In the Multimedia version of Mavis Beacon Teaches Typing, Mavis will occasionally speak 
to you, in addition to displaying a message box on the screen.    To prevent Mavis from 
speaking, turn this option Off.



"Progress" Menu Commands
The Progress menu commands allow you to view your progress in a number of different 
ways:

Show Graphs...
Report Card
Proficient Keys



"Show Graphs..." Menu Item

The Show Graphs menu item leads opens a new window containing the Graph Menu 
which lets you view your typing progress on any of more than twenty charts and graphs 
summarizing you accuracy, speed and error type.



"Report Card" Menu Item
The report card lets you view your lesson progress in summary form.    Choosing the Print
button (on printer equipped machines) will print a copy of the current report card.



"Proficient Keys" Menu Item

This option displays the keyboard, highlighting all of the keys for which your average 
speed exceeds your goal speed.    If a particular key is not shown, you can assume that it 
either has not been tested or that it is below the average in speed and accuracy.    This 
display can easily show your problem areas.



"Help" Menu Commands

The Help menu or the F1 function key accesses the familiar Windows Help system.    This
menu also presents you with several shortcuts for moving quickly within the Help 
system:

Index
Introduction
Keyboard
Menus
Audio Help
Using Help
About Mavis Beacon...



"Graph" Menu Commands
Mavis Beacon's extensive graphing capabilities can show you your typing progress in 
over twenty ways:

Choose a Graph
Previous Graph
Next Graph
Sort Order
Exit Graphs



"Choose a Graph" Menu Item
Select a graph to view from the list presented or move through the list using the Previous
Graph or Next Graph menu items.

Mavis creates graphs for the following topics:

Progress:    This graph shows your adjusted speed (including a penalty for errors) for
up to 26 of you most recent sessions from oldest (left) to this one (right).

Adjusted Speed:    Adjusted speed penalizes you for errors by subtracting one 
keystroke for each mistake.    This graph shows your adjusted speed for each 
letter key.

Speed:    This graph shows your typing speed for each letter key (while ignoring 
errors).

Accuracy:    For each of the letters or characters shown, the graph shows the 
percentage of the time you type it correctly.

Problem Keys:    This graph shows the keys on which Mavis believes you need the 
most work.    Along with speed and accuracy, Mavis considers how often the 
character occurs in written English - so that, everything else being equal, 
commonly occurring characters are drilled more frequently.    Mavis also considers 
the number of times each character was tested in past sessions so you get a 
chance to practice the entire keyboard.    The result of all these considerations are
represented on the graph.    Keys that require the most work have the biggest 
bars.

Errors by Hand:    This graph shows what percentage of the total error, in past 
lessons, were typed by each hand.    If one hand is more error-prone, this graph 
will quickly point that out.

Errors by Finger:    This graph shows what percentage of the total errors in past 
lessons were typed by each finger.    If one finger or a group of fingers is more 
error-prone, this graph quickly points that out.    Often, typists have the most 
difficulty with the pinks and index fingers.    Finger codes used in this graph are: 
(1) Left pinky, (2) Left ring, (3) Left middle, (4) Left index, (5) Right index, (6) 
Right middle, (7) Right ring, (8) Right pinky and (T) Right thumb.

Errors by Row:    This graph shows what percentage of errors in past lessons 
occurred on each of the four rows of the keyboard (not including the Spacebar 
row).    The rows are listed left to right, bottom to top, respectively.

Row Errors:    A "wrong row" error occurs when you are typing with the correct 
fingers but are basing your typing in the wrong row.    A frequent mistake of this 
type is typing 'F' for 'R' or vice versa.    (The cure for this is usually to reposition 
your hands over the Home Row).

Column Errors:    A column error occurs when you type a letter in the correct row 
but in the wrong vertical column as in typing an 'R' when you intended to type a 
'T'.

Mirror Errors:    A mirror image typing error happens when you type a key in the 
correct row and column but with the wrong hand.    This is, you might type a letter 



in the third row, say 'E', with the third finger of your left hand when you wanted to
type an 'I' with the same finger of the right hand.

Shift Errors:    Shift errors include typing upper case letters where you should be 
typing lower case ones (or vice versa), or substituting numbers for symbols.    It is 
important to depress the shift keys in rhythm with the rest of your key typing and 
to always remember to use one hand to strike the key and the other to depress 
and hold the shift key.

Backspace Errors:    Due to the placement of the backspace key at the upper right 
of the keyboard, it is easy to fall off the home row after backspacing and then 
make another error after just having corrected the first error!    This graph 
indicates if your typing contains this common fault.    The solution is to 
concentrate on recentering your hands over the home row after backspacing.

Substitution Errors:    This error occurs when you type a wrong letter in place of the
correct letter.    This is the most common typing error.

Doubling Errors:    A doubling error is what happens when you type a character 
twice, when you only meant to type it once.    An example of this is typing the 
word 'belt' as 'beelt.'    This often happens on keys that are closely spaced 
together on the keyboard and when your hands are tired.    Try to remember to 
strike the keyboard with a quick rhythmic stroke that only touches each key long 
enough to depress it.

Dropped Letters:    A dropped letter occurs when a letter in a word is left out, as 
when 'omit' becomes 'omt.'

Transpositions:    This error occurs when you reverse two consecutive letters in a 
word, such as when you type 'the' as 'eht.'    Transpositions also occur when you 
reverse a letter and a space position or a punctuation mark, such as when you 
type 'a nant' instead of 'an ant.'

Between Key Errors:    This error is caused by striking in between keys, resulting in 
typing two letters instead of one.    For example, you try to type an 'A', but hit in 
between keys and get 'AS.'    Often repositioning your entire body in front of the 
keyboard helps you get your overall finger placement back into shape.

Recovery After Errors:    This graph shows, for each alphabetic key, a relative error 
ranking for recovery after making an error.    Recovery measures how quickly the 
typist notices an error after making it and either begins to type the correct key or 
backspaces to the error and continues.    A large number of recovery errors 
indicates that the typist is probably trying to type too fast for their current skill 
level and that they are probably watching their hands instead of the material that 
is being typed.

Other Errors:    This graph shows all the errors that did not fit in any other category.



"Previous Graph" Menu Item
View the previous graph (as listed in the Choose a Graph menu item).



"Next Graph" Menu Item
View the next graph (as listed in the Choose a Graph menu item).



"Sort Order" Menu Item
The bar charts created by Mavis can be sorted in three different orders: 

Natural order: A normal sequence, usually alphabetic.

Worst First: Show keys ranked from worst to best based on performance in current 
topic.

Best First: Show keys ranked from best to worst based on performance in current 
topic.



"Exit Graphs" Menu Item
Selecting this item will close the graph window and return you to the Chalkboard.



Keyboard Shortcuts

Mavis provides a number of keyboard shortcuts (or direct action keys) for performing 
often used menu operations, as follows:

F1 Go to help
F2 Pause/Continue a lesson
F3 Keys and fingers tour
F4 Free typing practice
F5 Change sounds
F6 Turn metronome on/off
F7 Turn guide hands on/off
F8 Show proficient keys
F9 Select a graph
F10 Turn 10-Key lessons on/off

On extended keyboards, the follows function keys are also available:

F11 Play a game instead
F12 Typist options



Ergonomics
Using the correct posture at the keyboard can reduce eye strain and fatigue and will 
result in significantly better typing performance.    Follow these guidelines:



"Audio Help" Menu Item
The Audio Help Menu Item on the HELP MENU gives you a list of several topics on which 
you can get spoken help.    Choosing an item from the list will give you a simple audio 
explanation, telling you how that item works.



Dictation Typing
Dictation lessons teach you to type as if you were taking dictation, and still concentrate on 
speed and accuracy!    When in a dictation lesson the cursor shape will changed to one of    
four cassette tapes, to show you the status of audio.

Audio is Playing

Audio is Paused

Audio is Rewinding

Audio has reached the end, and has stopped.

To control playback of the audio, you may use the mouse buttons, or the keyboard.

· To pause the audio, click the right mouse button, or press CTRL-P.    To resume, click the 
right mouse button again, or press CTRL-P.    Whenever you stop playback, the audio 
also backs up approximately one second.

· To rewind the audio, click the left mouse button, or press CTRL-R.    The audio will 
continue to rewind as long as the button is down, and resume playing when it is 
released.

Choosing Dictation Lessons - From the Custom Lesson dialog, select Dictation Lesson 
from the Lesson Format listbox.    You may choose from lesson text from two sources, 
Business Letters, or your own text file.    

Creating Your Own Dictation Lesson - To create your own dictation lesson, you must 
create two files:    a Text file, and a matching Wave file that contains the audio portion of the
lesson.    Both of the files must have the same file name, but with the extensions ".txt" and 
".wav."    To create the Wave file, you will need to use a Multimedia sound utility program 
such as the Sound Recorder.    See also Creating Your Own Dictation Lesson    in the Mavis 
Beacon User Guide, and refer to the Multimedia Windows User Manual for instructions on 
using the Sound Recorder.


